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About us @ @

About the Johnson Controls Partner Learning Portal Because your goal is to apply what you've learned, our state-of-the-art facilities include fully
The Johnson Controls Partner Learning Portal has been developed to help people succeed at equipped labs for hands-on exercises. Portable equipment simulators enable the Training
creating and managing quality building environments. We, at Johnson Controls, understand Institute to bring many of its courses to your location, yet still enable you to practice what
that every individual has a different learning need. This learning platform has been developed you've learned without jeopardizing building operations.

for your own learning curve. Our mission is to provide high-quality learning experiences that

reflect both the current state of the industry today and the direction its heading in the future. ST GNP NEMERTE €Nk GOSGi T (RO ETmE £ C g At e ENpEma tn® MaetB €

working knowledge of environmental systems, including:
» Building Owners

Our curriculum has been developed by professional instructors who are experienced in the

. : : : : : . » Building Managers
building environments industry. Their extensive real-world experience and ability to share J J

their knowledge in a structured format assures you an enlightening and productive educational > Engineers

. » I r
experience. Operators

» Maintenance Technicians

» Learn from Certified Instructors* with years of industry experience » Property Managers
» Experiment in our labs, using specially designedequipment simulators
» Find the learning opportunities
» Expand your knowledge in industry topics such as:

» Building Automation Systems

» Energy Management

» Heating, Ventilating, and Air Conditioning Systems

» Preventative Maintenance

» Automated Building Controls

For further information on classes or help registering, please contact BTS-EMEAPartnerLearning@jci.com
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Training Options to Meet Your Needs

ONG

Our learning opportunities are designed to provide you with the knowledge and skills
necessary to effectively and efficiently operate your building’s systems. By using your newly
acquired abilities, you can maximize the potential of your building systems and increase your
return on investment. To help you take advantage of the benefits of our training, we offer

several ways to approach our courses. You can select from our:

e-learning Courses
To help you learn in our own space and time, we have developed and deployed several
e-learning modules, videos and job-aids in the learning platform. These are organized and

cataloged for your learning needs. Visit www.|ci-academy.com and select Catalog to browse

through the learning content.

Product Knowledge Webinars

We conduct regular product knowledge webinar sessions where several product experts talk
about new product launches and product features. These sessions are held to enhance your
Johnson Controls product knowledge and are free of cost. You will receive e-mail updates from

Johnson Controls regarding such webinar sessions.

Instructor-Led Classroom Learning Courses (Scheduled)
Regularly scheduled courses with both a classroom and lab component are conducted at our
Johnson Controls training locations. During class you will be using an iPad® to take notes and

highlight the material. When class ends you will take your notes and course material with you

on a USB Drive. Refer to the class schedules available at www.jci-aceademy.com for the dates,

locations, and prices of these courses. Note: No audio/visual recording equipment is allowed.

Instructor-Led Distance Learning Courses and Learning Packages

Learn in the convenience of your own home, office, or work location using Johnson Controls
instructor-led distance learning courses or learning packages. Learning packages include self-
study workbooks offering flexible, effective, cost-efficient opportunities to build knowledge
and skills. Our instructor-led distance learning courses and learning packages can be used

as preparation for a course, to refresh skills, or to provide an effective learning alternative if

attendance at a typical classroom course is impractical. Refer to www.jci-academy.com for the list

of instructor-led distance learning courses.

Courses Offered by Request Only

Some of our courses target a more specific audience and therefore, have lower demand. To
continue to satisfy the needs of those who still occasionally need these courses, selected courses
are only conducted upon request. These courses can be conducted at your site or at one of our

training locations. For this reason, these courses are not scheduled. To inquiry about scheduling a

course, contact BIS-EMEAPartnerLearning@jci.com.

Onsite Learning Programs

Johnson Controls training can help you make the most of your investment in learning by bringing
our instructors and classes to you or to the location of your choice. More and more companies are
realizing the value of bringing training Onsite. Our onsite Courses can be the most efficient and

cost-effective way to train as few as six employees.

For further information on classes or help registering, please contact BTS-EMEAPartnerLearning@jci.com
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Enrollment Information

ONG

To achieve the most effective training, carefully evaluate the course content and objectives to
match your learning requirements. Class size is limited and is offered on a first-register,

first- attend basis.

To browse our catalog and enroll for courses, please visit www.jci-academy.com. Payment

information is available on the PLP.

Confirmation of enrollment along with training location information will be sent to the learner
within five working days after receipt of your payment (if applicable). Upon receipt of your
confirmation, check it carefully and contact us via e-mail if you find any discrepancies. If you
do not receive an enrollment confirmation letter within two weeks prior to the start of class,

contact us to make sure that we have received your application. For information on training

locations and recommended hotels refer Training Locations & Hotel Information.

All flight & hotel booking are suggested to be done after you have received a class

confirmation e-mail from Johnson Controls 2 weeks prior to class date.

Substitution & Cancellation

Johnson Controls reserves the right to cancel classes and assumes no liability for expenses.
All registrants will be notified (via e-mail and phone) at least 15 days before the start of class
should a course be canceled. Full amount of the course will be refunded to learners, if such a

situation occurs.

Circumstances may occur that could prevent you from attending a course for which you
are enrolled. For this reason, we allow you to substitute another learner in your place at no

additional fee (needs to be communicated to BTS-EMEAPartnerLearning@jci.com).

If no substitute learner is available and you must cancel your enrollment, charges will be

applicable as follows-
» 100% of the amount will be refunded if cancelled before 3weeks of class start date.
» 50% of the amount will be refunded if cancelled within 3 weeks of class start date.

» No refund if cancelled within 10 days of class start date.

Schedule of Classes
The latest schedule of classes is available at www.jci-academy.com. The schedule is subject to

change.

For further information on classes or help registering, please contact BTS-EMEAPartnerLearning@jci.com
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Training Locations & Hotel Information

Learners must call the hotels directly to make reservations. The Johnson Controls Corporate
rate must be requested. Be sure to ask about complimentary shuttle services to and from our
learning centers. (These services are not available everywhere). Reservations made through a

travel agency are not eligible for the discounted rate.

Training facility location 1

Block D, Floor 3, Office Park Building #56,
Dubai Internet City,

Dubai, United Arab Emirates

Google map location: https://goo.gl/maps/
BUDkuKwjehMBhFik6

Located approximately 25 mins from Dubai
International Airport

(DXB) and 35 mins from Al Maktoum
International Airport (DWC).

Suggested Hotel Accommodations

Holiday Inn Express Dubai — Internet City,

Al Sufouh Dubai Knowledge Park — Dubai,UAE

Phone: +971 4 427 5555

Website:

Google map location:

For further information on classes or help registering

Training facility location 2

DSO, Light Industrial Unit Phase 5, Unit C-O2
Dubai Silicon Oasis, Dubai United Arab
Emirates

Google map location: https://goo.gl/maps/
XNLza7WKkW3mtCcW7

Located approximately 20 mins from Dubai
International Airport (DXB) and 35 mins from

Al Maktoum International Airport (DWCQC).

, please contact BTS-EMEAPartnerLearning@jci.com
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Suggested Hotel Accommodations

Premier Inn Dubai Silicon Oasis Hotel

Sheikh Mohammed Bin Zayed Road, Dubai Silicon QOasis,
Dubai UAE

Phone: +971 4 382 1555

Website:

Google map location:

Radisson Blu Hotel Apartments
Plot #26-077 , Dubai Silicon Oasis
Dubai, United Arab Emirates
Phone: +971 4 350 1111

Website:

Google map location:
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https://www.google.com/maps/place/Johnson+Controls/@25.1049767,55.1693659,18z/data=!4m5!3m4!1s0x3e5f6bbc597a5285:0x72349726c6f84e5!8m2!3d25.1050178!4d55.1684566
https://www.google.com/maps/place/Johnson+Controls/@25.1049767,55.1693659,18z/data=!4m5!3m4!1s0x3e5f6bbc597a5285:0x72349726c6f84e5!8m2!3d25.1050178!4d55.1684566
https://www.ihg.com/holidayinnexpress/hotels/us/en/reservation
https://www.ihg.com/holidayinnexpress/hotels/us/en/reservation
https://www.google.com/maps/place/Johnson+Control+Training+Centre/@25.1305863,55.385645,15z/data=!4m5!3m4!1s0x0:0x32052d7870b1f1f1!8m2!3d25.1305863!4d55.385645
https://www.google.com/maps/place/Johnson+Control+Training+Centre/@25.1305863,55.385645,15z/data=!4m5!3m4!1s0x0:0x32052d7870b1f1f1!8m2!3d25.1305863!4d55.385645
https://goo.gl/maps/8QfpWZaLwES2 
https://global.premierinn.com/en 
https://www.google.ae/maps/dir/Premier+Inn+Dubai+Silicon+Oasis+Hotel+-+Dubai//@25.1230678,55.3394417,13z/data=!4m9!4m8!1m5!1m1!1s0x3e5f643fa6874ca9:0x8d8de94d9a4c8759!2m2!1d55.3744512!2d25.1228155!1m0!3e0!5m1!1e2
https://www.google.ae/maps/dir/Premier+Inn+Dubai+Silicon+Oasis+Hotel+-+Dubai//@25.1230678,55.3394417,13z/data=!4m9!4m8!1m5!1m1!1s0x3e5f643fa6874ca9:0x8d8de94d9a4c8759!2m2!1d55.3744512!2d25.1228155!1m0!3e0!5m1!1e2
https://www.radissonhotels.com/en-us/hotels/radisson-blu-apartments-dubai-silicon-oasis
https://www.radissonhotels.com/en-us/hotels/radisson-blu-apartments-dubai-silicon-oasis
https://www.google.com/maps/place/Holiday+Inn+Express+Dubai+-+Internet+City/@25.1046054,55.1670226,18z/data=!4m8!3m7!1s0x3e5f6b6ce808c8fd:0xeb235017c5832df2!5m2!4m1!1i2!8m2!3d25.1043857!4d55.1660724
https://www.google.com/maps/place/Holiday+Inn+Express+Dubai+-+Internet+City/@25.1046054,55.1670226,18z/data=!4m8!3m7!1s0x3e5f6b6ce808c8fd:0xeb235017c5832df2!5m2!4m1!1i2!8m2!3d25.1043857!4d55.1660724
https://www.google.com/maps/place/Radisson+Blu+Hotel+Apartments+Dubai+Silicon+Oasis/@26.9583455,-4.4610265,3z/data=!4m9!3m8!1s0x3e5f643ef34e7497:0xbd49a1b2c7763ef1!5m3!1s2019-12-16!4m1!1i2!8m2!3d25.1241919!4d55.3774822
https://www.google.com/maps/place/Radisson+Blu+Hotel+Apartments+Dubai+Silicon+Oasis/@26.9583455,-4.4610265,3z/data=!4m9!3m8!1s0x3e5f643ef34e7497:0xbd49a1b2c7763ef1!5m3!1s2019-12-16!4m1!1i2!8m2!3d25.1241919!4d55.3774822

Metasys Building End-User Operators/Engineers Learning Path

C-388-EN Metasys system C-389-EN Metasys system
extended architecture for O R extended architecture for
Building Operators Building Engineers

} !

C-3021-EN Introduction to Metasys User Interface

For further information on classes or help registering, please contact BTS-EMEAPartnerLearning@jci.com
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Metasys ABCS Learning Path @

Click any course to Learn the course detalils...

HVAC/Controls
C-3021-EN : \_) Courses
. Suggested elLearnings
Introduction to Metasys K . Metasys® Field
User Interface — HVAC Introduction — Environment \_) (B:Acpet”
t( N o ontroller
N Q Metasys®
C-13072-EN — HVAC Introduction - Systems E'glrirlj)leNr
Fundamentals of HVAC = . ‘ Metasys®
Systems Suggested elLearnings \_) Sefne/SameD
i( > L HVAC Introduction - Controls Suggested el_earnings/video MODBUS
\_) Integration
C-13073-EN B
Fundamentals of BMS FAN 410 - 1.0 Introduction, HVAC Drawings & System Layouts \-) Graphics
Control Systems f
E-Learni
@ < > Introduction To Metasys \_) Vid:zmmgs/
-
Field Level Career Path Supervisory Level B _ ) \-) éCI Ich)I(I
Engineering \/ Engineering BACnet 101: Basic BACnet Terminology and Concepts orpeliEe
=
v . |
C-3022 Metasys User
: C-391-EN Metasys system
C-7010-EN LN-Series LONWORKS - —
C-14002-EN KNX | ™ N ’ : extended architecture Interface Graphics
L -— Protocol — Controllers Programming and . . Editor
Certification : Engineering & Setup
Troubleshooting i
| Modbus Integration T Metasys Ul
BACnet
’ Suggested elLearnings/video C- 10076 -EN Commis- C-397-EN Metasys C-10895-EN None
N L system extended = Configuring The > — Completed
C-4703-EN Metasvs FEC sioning NIEx9 Modbus | < > P
_ e FAN 410 - 2.0 BACnet Controllers Intearati architecture Advanced Archive Database &
Operations/Troubleshooting & Devices ntegrations , ,
— - Engineering Metasys Ul
3 \ l GGT
l‘ >l B C-10077-EN |
FAN 410 - 4.0 BACnet Cable & Rhaans Suggested elLearnings/video C-3002-EN Metasys
Installation Standards Programming NIEX9 4 Graphics Generation | —
Engineering & Programming FAN 410 - 5.1 Installation . = T
I Validations Using FIT Tool r
= BACnet-103: BACnet Communications — Messaging
-l
: |
C-4704-EN Metasys FEC Custom BACnet-102: BACnet -
Programming — Communications - Network BACnet-104: Expanding on BACnet Standard Capabilities
L Structures =

For further information on classes or help registering, please contact BTS-EMEAPartnerLearning@jci.com
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C-13072-EN Fundamentals of HVAC Systems @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -

Duration 1 Day » Technicians/Engineers with minimal experience working on HVAC » Fundamental understanding of Microsoft® Windows™
Systems

Category Controls

Map Metasys ABCS Learning Path

Course Description Learning Objectives
This course is designed to provide technicians, engineers with basic knowledge of HVAC At the end of this module, you will be able to:
to have an overview of the refrigeration cycle and its components, understand P-H » Define the major processes in a HVAC system

Diagrams and Psychometric charts, Air side components — AHUs, Ducts and Airflow ,

» |llustrate a Refrigeration cycle on a P-H Chart
Water side components — Piping , pump curves and sizing.

» Use a Psychometric Chart to plot a cooling and dehumidifying process
» Explain the different components used on the Air-Side of a system

» Explain the different components used on the Water-Side of a system

For further information on classes or help registering, please contact BTS-EMEAPartnerLearning@jci.com
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https://jci-academy.com/contentdetails?id=65F8650D3CB84EEAB31426340A4F82F9
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C-13073-EN Fundamentals of BMS Control Systems @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -

Duration 2 Days » Technicians/Engineers with minimal experience working on HVAC » Fundamental understanding of Microsoft® Windows
Control Systems

Category Controls

Map Metasys ABCS Learning Path

Course Description Learning Objectives

This course is designed to provide technicians, engineers with basic knowledge of controls At the end of this module, you will be able to:
and HVAC to have an overview of the Building Management Systems that includes

controls fundamentals, VAVs, CAVs and their control, Chiller Sequencing Strategies,
Protocols and BMS Equipment selection. Preparing an I/O summary for a BMS.

» Define the basic concepts used in a control system
» ldentify the types of Variable air volume systems
» Classify the various chiller sequencing strategies

» Sketch an I/O summary

» Explain BMS equipment selection

For further information on classes or help registering, please contact BTS-EMEAPartnerLearning@jci.com
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C-14002-EN KNX Certification QED

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -
Duration 5 Days » End Users and/or Authorized Building Controls Specialists/
Contractors Only.
Category Controls
Map Metasys ABCS Learning Path

Course Description Learning Objectives
KNX is the worldwide leader in hospitality sector, bringing thousands of users and Course Topics:
professionals in a unique technological world ready for the future. » KNX Project Design ETS Professional: Basic

» KNX Project Design ETS Professional: Advanced (only for informative purposes)
» KNX Commissioning ETS

» KNX Diagnostics & Trouble Shooting ETS
» KNX System arguments

» KNX System overview

» KNX TP Topology

» KNX TP Telegram

» KNX Bus devices

» KNX TP Installation

» KNX Powerline

» KNX RF

Certification Exam:
At the end of the KNX Basic course there is a theoretical and practical exam in order to test

the course participant’s basic KNX knowledge.

For further information on classes or help registering, please contact BTS-EMEAPartnerLearning@jci.com
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C-10076-EN -Commissioning NIEx9 Modbus Integrations @ @

Course Information - PLP Link

Course Type Classroom Audience - Pre-Requisites Course (s) -
Duration 1 Day » End Users and/or Authorized Building Controls Specialists/ » Modbus Protocol Overview for Technicians Prior to the Class
Contractors Only. » Download and obtain a temporary license for the VMD Generator
Category Controls Express.
Map Metasys ABCS Learning Path » Download and obtain a temporary license for Multi-application
protocol explorer (optional, but recommended).

Course Description Learning Objectives

Learn how to commission a NIEx9 Modbus integration using a VMD file previously created. Course Topics:

» Introduction to NIEx9 for Third Party Modbus Integration (Review of prework)

» Modbus Communication (Review of prework)

» Licensing

» The Vendor Model Definition (VMD) File

» Integrating the NIEx9 (including Troubleshooting)

» Mass Changes Tool

» Objectives

» Describe how the NIEx9 is integrated into Metasys using Modbus communications

» Integrate a NIEx9 into Metasys using a VMD file.

» Diagnose problems that can occur during an integration

» Recognize how Mass Changes Tool can be used to organize data

For further information on classes or help registering, please contact BTS-EMEAPartnerLearning@jci.com
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C-10077-EN Programming NIEx9 Modbus Tables *** @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -
Duration 2 Days » Controls Tec.hnicians, Lead Systems Specialists, System Designer, Prior the Class
System Engineers » Download and obtain a temporary license for VMD Generator
Category Controls
Express.
Map Metasys ABCS Learning Path

» Download and obtain a temporary license for multi-application

protocol explorer (optional, but recommended).

Course Description Learning Objectives
Learn how to use the VMD Generator Express (VGE) to create and modify Modbus tables Course Topics:
needed for the NIEX9 integration platform. » Introduction to NIEx9 for Third Party Modbus » Integrate a NIEx9 into Metasys using
Integration (Review of pre-work) a VMD file.
» Modbus Communication (Review of pre-work) » Diagnose problems that can occur
» Licensing during an integration.
» The Vendor Model Definition (VMD) File » Recognize how Mass Changes Tool
» Integrating the NIEx9 (including Troubleshooting) can be used to organize data.
» Mass Changes Tool » Create a Modbus device VMD
» About the Modbus device VMD file file that enables the connection
» Create NIEx9 Modbus VMD files between Modbus and Metasys.
» Certification Assignment
» Objectives
» Describe how the NIEX9 is integrated into
Metasys using Modbus communications

For further information on classes or help registering, please contact BTS-EMEAPartnerLearning@jci.com
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C-388-EN Metasys system extended architecture for Building Operators @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -
Duration 3 Days » End Users and/or Authorized Building Controls Specialists/ » Fundamental understanding of Microsoft® Windows™
Contractors Only.
Category Controls
Map Metasys Building End-User
Operator

Course Description Learning Objectives

This three-day course teaches building personnel how to make the most effective Course Topics:
and efficient use of the features of a Metasys system extended architecture facility
management system. This course is for building personnel who have new installations of
Metasys system extended architecture using NAEs or NIEs or for those who have migrated
from their existing Metasys system.

» Metasys system extended architecture Overview

» Help File System

» Basic Navigation of the System with the User Interface
» Commanding Objects

» Scheduling

» Setting up Alarms

» Responding to Alarms

» Trending

» Tantalization

» Graphics

» Hands-on Labs

» Final Review

For further information on classes or help registering, please contact BTS-EMEAPartnerLearning@jci.com
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C-389-EN Metasys system extended architecture for Building Engineers @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -
Duration 5 Days » End Users and/or Authorized Building Controls Specialists/ » Fundamental understanding of Microsoft® Windows™
Contractors Only.
Category Controls
Map Metasys Building End-User
Operators

Course Description Learning Objectives
This course teaches building personnel how to make the most effective and efficient use Course Topics:
of the features of a Metasys system extended architecture facility management system. » Metasys system extended architecture Overview > Reviewing Control Strategies
This course contains additional topics not covered in the Metasys system extended » Help File System » Backing Up the Data
architecture for Building Operators course. » Basic Navigation of the System with the User » Hands-on Labs

Interface » Final Review

» Commanding Objects
» Scheduling

» Setting Up Alarms

» Restponding to Alarms
» Trending

» Totalization

» Graphics

» Setting Up Passwords
» User Views

» Audit Trails

» Sending Reports to Printers, Pagers, Emails, etc.

» Adding Inputs and Outputs to a Controller

For further information on classes or help registering, please contact BTS-EMEAPartnerLearning@jci.com
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C-3021-EN Introduction to Metasys® User Interface @ @

Course Information - PLP Link

Course Type Classroom Audience - Pre-Requisites Course (s) -
Duration 6 Hours » End Users and/or Authorized Building Controls Specialists/ » Fundamental understanding of Microsoft® Windows™
Contractors Only.
Category Controls
Map Metasys ABCS Learning Path
Metasys Building End-User
Operators
Course Description Learning Objectives
This course is designed for customers who need to learn how to perform daily tasks using Course Topics:
the Metasys® User Interface. After completing this course, participants will be able to » Navigate the New User Interface
navigate through the Metasys® Ul to find the information that is relevant to your » Understand the differences of the Space Dashboard and Equipment Dashboard
building. You will be able to complete daily tasks using the interface by focusing on issues » Selecting widgets
that are critical to your site and take action on potential problems, leveraging advanced » Using the Alarm Manager
reporting capabilities for building analysis. » |ssuing commands
» Search for and report on Metasys® data using Advanced Search
» Understand how the User Interface may be customized at your site
» Finding additional resources

For further information on classes or help registering, please contact BTS-EMEAPartnerLearning@jci.com
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C-4703-EN Metasys FEC Operations/Troubleshooting @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -

Duration 3 Days » End Users and/or Authorized Building Controls Specialists/ » Fundamentals of HVAC Systems (C-13072) & Fundamentals of
Contractors Only. HVAC Control Systems(C-13073) or equivalent experience.

Category Controls

Map Metasys ABCS Learning Path

Course Description Learning Objectives

Upon successful completion of this course, the participants will be able to commission In this two-day course, students will learn how to access and read existing strategies and how to
BACnet MS/TP Field Equipment Controller (FEC) systems using the Controller download and test existing configurations on the Field Equipment Controllers (FECs). The course
Configuration Tool (CCT) through a wireless commissioning converter (BTCVT). is designed for building personnel who want to gain a better understanding of HVAC Control

Systems and Johnson Controls FEC devices.

Course Topics:

» Overview of FEC Controllers » Hands-on Labs
» Controller Configuration Tool (CCT) Overview » Final Review
» Bluetooth Wireless Communications

» Downloading and Uploading FEC Controllers

» Control Strategies and State Control

» Modifying Points in an FEC Controller

» FEC and IOM Hardware

» MS/TP Communications

» Trunk Utilities

» VMA Controller

» |nstallation Practices

» Simulation Mode in CCT

For further information on classes or help registering, please contact BTS-EMEAPartnerLearning@jci.com
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C-4707-EN Metasys FEC Engineering & Programming @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -

Duration 3 Days » End Users and/or Authorized Building Controls Specialists/ » Fundamentals of HVAC Systems (C-13072) & Fundamentals of
Contractors Only. HVAC Control Systems(C-13073) or equivalent experience.

Category Controls

Map Metasys ABCS Learning Path

Course Description Learning Objectives

Develop standard and modified HVAC system applications using Controller Configuration Students will learn how to program and test control strategies for theFieldEquipment Controllers
Tool (CCT). Modify and/or augment the software of CCT software for a small to mid-size (FECs) in this three-day course. The course is designed for experienced building personnel
projects to onsite changes. who want to expand their knowledge of HVAC Systems and Johnson Controls FEC devices.

Course Topics:

» FEC Controller Overview

» Controller Configuration Tool (CCT) Overview
» Control Strategies

» State Control Basics

» Creating a New Application
» Simulation Mode

» Program Modification

» Program Analysis

» Data Flow

» Side loops

» Hands-on Labs

» Final Review

For further information on classes or help registering, please contact BTS-EMEAPartnerLearning@jci.com



https://jci-academy.com/contentdetails?id=B6B84106481B431A8E8D6321CD68E5C5
https://jci.sumtotal.host/core/pillarRedirect?relyingParty=LM&url=https:%2F%2FJCI.sumtotal.host%2Flearning%2Fcore%2Factivitydetails%2FViewActivityDetails%3FUserMode%3D0%26ActivityId%3D298138%26ClassUnderStruct%3DFalse%26CallerUrl%3D%2Flearning%2Flearner%2FHome%2FGoToPortal%3Fkey%3D0%26SearchCallerURL%3Dhttps%253A%252F%252FJCI.sumtotal.host%252Fcore%252FsearchRedirect%253FViewType%253DList%2526SearchText%253D12364%2526startRow%253D0%26SearchCallerID%3D2

mailto:BTS-EMEAPartnerLearning%40jci.com?subject=

C-4704-EN Metasys FEC Custom Programming @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -

Duration 3 Days » End Users and/or Authorized Building Controls Specialists/ » Metasys FEC Systems Engineering (#4707) and FEC controller
Contractors Only. programming experience.

Category Controls

Map Metasys ABCS Learning Path

Course Description Learning Objectives

This course provides participants with the skills to use CCT to make major modifications to Students will learn how to create and test customized control strategies for FEC controllers in
standard systems to complete unusual HVAC system control sequences for BACnet MS/TP this 4.5-day course.The course is designed for experienced building personnel who want to
Field Equipment Controller (FEC) devices. expand their knowledge of HVAC Control Systems and Johnson Controls FEC devices.

Course Topics:

» Central Plant Application in CCT
» Modules and Blocks in CCT

» Activities as Containers

» Hybrid Activities

» PID and PID Pre-Processor

» State Tables

» Sequencer and Multi-stage Controller
» PRAC+ and PMAC

» Review of Custom Lab

» Hands-on Labs

» Final Review

For further information on classes or help registering, please contact BTS-EMEAPartnerLearning@jci.com
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C-391-EN Metasys system extended architecture Engineering & Setup @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -

Duration 5 Days » End Users and/or Authorized Building Controls Specialists/ » Metasys FEC Systems Engineering (#4707). A familiarization
Contractors Only. with BAS systems or knowledge of operating the Metasys system

Category Controls

extended architecture would also be beneficial

Map Metasys ABCS Learning Path

Course Description Learning Objectives

Students will learn how to set up and manage the NAE database and to use the power of Course Topics:

the System Configuration Tool to generate an NAE database from existing ASC controller » Course Introduction
programming. » System Overview and Comparisons

» NAE User Interface Overview

» System Configuration Tool Overview

» Adding BACnet Devices

» Newest Feature Objects

» Overview: Designing a New Archive Database
» Hands-on Labs

» Final Review

For further information on classes or help registering, please contact BTS-EMEAPartnerLearning@jci.com
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C-397-EN Metasys system extended architecture Advanced Engineering @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -

Duration 5 Days » End Users and/or Authorized Building Controls Specialists/ » Metasys system extended architecture Engineering and Setup
Contractors Only. (#391) or Metasys system extended architecture for Building

SR Homiliels Engineers (#389) & Student must have background in operating

Map Metasys ABCS Learning Path and/or engineering the Metasys system extended architecture.

Course Description Learning Objectives

Experienced personnel will learn how to write advanced programs for facility-wide or Course Topics:

specific mechanical control applications using the System Configuration Tool (SCT). » Review Metasys system extended architecture Control Objects (Interlocks, Multiple
Students will build, modify and troubleshoot routines they create. Commands, LCT, etc.)

» Reset Strategies

» Sequencing Equipment

» Rotation of Equipment

» Operating Equipment per Load Needs

» Lead Lag Strategies

» Creating Calculations Including Tonnage, Highest Daily Temperature, etc.
» Student Directed Topics and Activities

» Hands-on Labs

» Final Review

For further information on classes or help registering, please contact BTS-EMEAPartnerLearning@jci.com
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C-3002-EN Metasys Graphics Generation Tool @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -

Duration 3 Days » End Users and/or Authorized Building Controls Specialists/ » Metasys system extended architecture for Building Engineers
Contractors Only. (#389) OR Metasys system extended architecture Engineering

Category Controls

and Setup (#391).
Map Metasys ABCS Learning Path

Course Description Learning Objectives

This course teaches students how to create and modify the custom graphics used to both Course Topics:

monitor and actively change building parameters and settings in a Metasys automation » Introduce the “Style Guide'”

system. It is a three-day online internet course which combines active instructor » Familiarize the student with how to commission graphics.

facilitation with student practice sessions with the facilitator available for questions. » Familiarize the student with how to create new graphics using the Graphic Generation Tool.
This course is for individuals already familiar with Automation System graphics or other » Provide an opportunity for hands-on practice implementing key Graphics+ tasks.

computerized graphic creation.

In this three-day course, students will learn an overview of the Graphics + tool with its
features and terminology.

For further information on classes or help registering, please contact BTS-EMEAPartnerLearning@jci.com
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C-10895-EN Configuring the Archive Database & Metasys Ul @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -

Duration 2 Days » End Users and/or Authorized Building Controls Specialists/ » Metasys system extended architecture Engineering and Setup
Contractors Only. (#391).

Category Controls

Map Metasys ABCS Learning Path

Course Description Learning Objectives

This course focuses on the tasks related to configuring spaces and equipment for Objectives

the Metasys Ul, for a new Metasys site You will learn the importance of engaging the At the end of this lesson, you will be able to:

customer in defining how the site appears in the Ul, how to configure the Ul using the » Introduce the customer to their newly created Metasys User Interface for New project
Rapid Archive Creation (RAC), and finally the tasks related to the customer turnover » Use SCT to geneate the database with the Metasys Ul configure Spaces and Equipment
meeting related to the Ul. You will complete. » Describe the importance of working with the customer to define the spaces tree

» Describe how configuration decisions impact the data visible in the Ul

Course Topics:

» Exploring the Metasys Ul

» Planning for the Metasys Ul for New site
» Rapid Archive

» Customer Turnover of the Metasys Ul.

For further information on classes or help registering, please contact BTS-EMEAPartnerLearning@jci.com
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C-3022-EN Metasys® User Interface Graphics Editor @ @

Course Information - PLP Link

Course Type  Classroom Audience - Pre-Requisites Course (s) -

Duration 6 Hours » End Users and/or Authorized Building Controls Specialists/ » Metasys system extended architecture Engineering and Setup
Contractors Only. (#391) & Configuring the Archive Database & Metasys Ul

Category Controls

(C-10895-EN)
Map Metasys ABCS Learning Path

Course Description Learning Objectives

This course is designed for customers who have experience with the Metasys® User Course Topics:

Interface, but want or need to learn how to create Metasys® Ul Graphics. After » Access the Graphics Manager through the User Online/Offline
completing this course, participants will beable to navigate the Metasys® Graphics » Navigate the Graphics Manager

Manager, import and export graphics and associate a graphics to a space, equipment » Import and export graphics using the Offline User Interface
definition, or piece of equipment and add custom behaviors to a graphic. » Navigate through the Graphics Editor

» Create and edit the Master Layer for a site

» Create, edit, and associate a graphic to a space or piece of equipment
» Create and edit a floorplan

» Create and edit user defined graphics templates

» Add custom behaviors to graphics

For further information on classes or help registering, please contact BTS-EMEAPartnerLearning@jci.com
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C-7010-EN LN-Series LONWORKS Controllers Programming And Troubleshooting

O @®

Course Information - PLP Link

Course Type  Classroom Audience -
Duration 5 Days

Contractors Only.
Category Controls
Map Metasys ABCS Learning Path

Course Description

» End Users and/or Authorized Building Controls Specialists/

Learning Objectives

Pre-Requisites Course (s) -

» Metasys system extended architecture Engineering and Setup
(#391) & Student must bring their laptop to class with a licensed
version of LN Builder installed, and a LON Talk Adapter such as
the 75010 USB interface

This course provides an opportunity for hands-on practice using the Metasys system LN
controllers to configure typical applications for each controller type, using the LN-Builder
database management tool. The course also provides an opportunity to map LonWorks
points into the Metasys extended architecture system.

Objectives:

After completing this course, the learner will

be able to:

» Select appropriate Metasys system LN
LonWorks device

» Configure Metasys system LN Application
Specific Controllers

» Apply a simple strategy using a Metasys
system LN Programmable Controller

» Configure the NAE for LON

Course Topics:

» Introduction to the Metasys system LN series
of LonWorks controllers

» Obtaining & installing software plug-ins

For further information on classes or help registering, please contact BTS-EMEAPartnerLearning@jci.com

» Obtaining other Johnson Controls support
material.

» Johnson Controls Metasys system LN
Application Specific product

» Controller selection,

» Configuration peculiarities

» Johnson Controls Metasys system LN
Programmable products

» Introduce the Graphical Programming
Language

» Configuring the NAE for LON,

» Employ standard snippets and master
library objects

» Build and save custom Snippets
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